TI Designs
Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design

Description
This TI Design uses Texas Instruments’ nano-power operational amplifiers, comparators, system timers, temperature sensors, and the multi-standard 2.4-GHz wireless microcontroller (MCU) platform to demonstrate an ultra-low-power carbon monoxide detector with extremely long battery life and no wiring required.

Resources
- TIDA-00756 Design Folder
- LPV811 Product Folder
- TLV3691 Product Folder
- CC2650 Product Folder
- TMP103 Product Folder
- TPL5111 Product Folder

ASK Our E2E Experts

Features
- Use of Nano-Power Analog Ultra-Low-Power Design Resulting in 10-Year Battery Life From Single CR2032 Coin Cell
- Carbon Monoxide Gas Sensor and Analog Logic Always Powered On To Enable Continuous Monitoring and Fast Response Times
- Bluetooth® Low Energy (BLE) Wireless Connectivity Reduces Installation Costs and Allows Multiple Sensors to Communicate With Single Host
- Self-Check and End-of-Life Monitoring Recognizes Malfunctioning Gas Sensor and Reports Status Every Five Minutes (Configurable)
- Carbon Monoxide Gas Detection Range of 0 to 1000 ppm With ±15% Accuracy

Applications
- Fire Safety Systems: Gas Detection
- HVAC Systems: Air Quality and Gas Detection
- Battery Powered Systems
- Building Automation

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other important disclaimers and information.

All trademarks are the property of their respective owners.
1 System Overview

1.1 System Description

Carbon monoxide (CO) is a colorless, odorless, tasteless, poisonous gas produced by the incomplete burning of fuels such as coal, kerosene, natural gas, and propane. Combustion engines such as those found in cars and lawn mowers can also produce CO. Many industrial and building automation systems rely on CO sensors to warn users when CO concentrations reach unsafe levels. Increasingly, these systems use wireless sensor nodes to reduce the installation costs and make the systems more flexible for future expansion by eliminating wiring. However, one of the major limitations for a large wireless network is power. Also, because these systems are battery powered, the maintenance cost associated with periodic battery replacement can become prohibitive.

Enabled by Texas Instruments’ nano-power amplifiers, comparators, system timers, temperature sensors, and the SimpleLink ultra-low-power wireless MCU platform, the Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design demonstrates a wireless CO sensor node requiring no wiring while also fully maximizing the battery life.

At a high level, this TI Design consists of a CR2032 coin cell battery, one nano-power op amp, one nano-power comparator, an ultra-low-power wireless MCU, a nano-power system timer, a temperature sensor, and an electrochemical CO sensor. The op amp forms a transimpedance amplifier to gain and filter the electrochemical CO sensor current. The comparator generates an interrupt to the wireless MCU when the voltage output of the transimpedance amplifier reaches a level corresponding to an unsafe CO concentration. In this manner, the MCU can operate in its lowest power shutdown mode during times when the CO level is within acceptable limits and only wakes up to monitor the CO level when it reaches unsafe limits. The nano-power system timer generates a periodic interrupt to the wireless MCU such that the MCU can carry out a check of the sensor and send a beacon to the host indicating the status of the system. The temperature sensor is used to adjust the CO concentration calculation in cases where the sensor output varies with temperature. Due to the nano-amp operation of the analog signal chain components and the ultra-low power consumption of the wireless MCU, this TI Design achieves a 10-year battery life from a single CR2032 coin cell battery.

This design guide addresses component selection, design theory, and the testing results of this TI Design system. The scope of this design guide gives system designers a head-start in integrating TI’s nano-power analog components, and the SimpleLink ultra-low-power wireless MCU platform.

The following subsections describe the various blocks within the TI Design system and what characteristics are most critical to best implement the corresponding function.

1.1.1 Operational Amplifier

The electrochemical gas sensor outputs a current in the nano-amp range, which must be converted to a voltage and amplified using a transimpedance amplifier. A filtering function is also necessary to limit the noise bandwidth of the system before reaching the input to the comparator and microcontroller’s analog-to-digital converter (ADC). The filtering function also limits the response of the system to fast changes in gas concentration.

For an extremely long battery life, this TI Design uses the LPV811 because of its low current consumption of 425 nA (typical). Other considerations that make the LPV811 ideal for this TI Design are its low input voltage offset and low input bias current, which allow use of high-value resistors, and rail-to-rail operation on both input and output. Additionally, the LPV811 integrates EMI protection to reduce sensitivity to unwanted RF signals, which is useful for low-power designs because of their high-impedance nodes.

1.1.2 Comparator

To maximize power savings, this TI Design keeps the MCU in its lowest power shutdown mode the majority of the time and only wakes the MCU when the CO level reaches unsafe levels. To accomplish this, a comparator circuit is used to convert the amplified and filtered version of the sensor output into a digital signal, which can be used as a wakeup interrupt to the MCU.
The low current consumption of only 75 nA (typical) makes the TLV3691 in this TI Design ideal. Other considerations for the comparator in this reference design include its low input voltage offset and low input bias current. Additionally, the TLV3691 features a rail-to-rail input stage with an input common mode range, which exceeds the supply rails by 100 mV, thereby preventing output phase inversion when the voltage at the input pins exceed the supply. This translates not only into robustness to supply noise, but also maximizes the flexibility in adjusting the comparator threshold in this design.

1.1.3 Ultra-Low-Power Wireless MCU

In this TI Design, transmitting the sensor information to some central location for processing is necessary. However, because power consumption is always a concern in battery-based applications, the radio and processor must be low power. Also, the wireless protocol required for the end-equipment system is an important consideration for the selection of the radio device.

With TI's SimpleLink ultra-low-power wireless MCU platform, low power with a combined radio and MCU enables an extremely long battery life for sensor end-nodes. Furthermore, the CC2650 is a multi-standard device with software stack support for Bluetooth Smart, ZigBee, 6LoWPAN, and ZigBee RF4CE. In this TI Design, the Bluetooth Smart protocol is the protocol of choice, but the hardware as built can work with other protocols as well.

1.1.4 Nano-Power System Timer

This TI Design is able to achieve extremely long battery life by means of a nano-power system timer. The use of this type of device replaces the internal timer of any standard microcontroller with a discrete analog system timer that consumes much less power than the microcontroller's internal timer. A nano-power system timer can be used either to bring an MCU out of sleep mode by means of a pin interrupt, or to completely shut off power to the system, in whole, or in part.

In this TI Design, the TPL5111 device was chosen to generate a wakeup interrupt to the MCU, which allows the MCU to stay in it shutdown mode the majority of the time, reducing the MCU's off-state current drawn from the battery to the hundreds of nano-amps. The timer interval is user-selectable by means of a resistor and can range from 100 ms up to two hours, with a typical time base accuracy of 1%. The TPL5111 device regularly brings the MCU out of shutdown mode such that it can carry out a set of tasks including sensor check and transmission of a beacon to the host.

1.1.5 CO Sensor

The sensor chosen for the TI Design is the Figaro TGS5342 two-terminal electrochemical carbon monoxide sensor. This sensor was chosen due to the availability of characterization data across multiple CO levels as well as sensor performance data in different environmental conditions. The sensor also supports a 10-year lifetime, which is required for this TI Design.

While the test results collected for this TI Design are focused on a particular sensor part number, it is expected that similar results can be obtained with any similarly specified two-terminal electrochemical sensor.

1.1.6 Temperature Sensor

The current output of electrochemical CO sensors can vary with temperature. For example, at a concentration of 400 parts per million, the current output of the TGS5342 CO sensor can be 20% higher at 60°C and almost 40% lower at 0°C compared to the current output at 20°C.

In this TI Design, firmware in the MCU adjusts gas concentration calculations using an internal temperature correction table and the temperature reading from the TMP103. The TMP103 is capable of reading temperatures to a resolution of 1°C. The temperature correction table was derived using information in the sensor datasheet. To save power and extend battery life, the TMP103 sensor supply voltage is only supplied when a temperature reading is needed.
1.1.7 Coin Cell Battery

The power source for this TI Design is a CR2032 lithium-ion coin cell. The selection of the CR2032 coin cell battery as the power source was due to the ubiquity of that battery type, particularly in small form factor systems such as a sensor end-node.

The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage remains relatively flat throughout the discharge life until the cell is nearly depleted. When the cell is depleted, the output voltage drops off relatively quickly.

The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells, particularly at lower temperatures. This superiority is due to lithium-ion cells having a non-aqueous electrolyte that performs better than aqueous electrolytes commonly found in alkaline batteries. However, the CR2032 coin cell battery and the gas sensor (see Section 1.1.5) are the limiting components in terms of the operating temperature range; all of the integrated circuits and other electrical components are specified to operate at a wider temperature range than the battery and gas sensor. Therefore, the specified operating temperature range of the TI Design system is 0°C to 50°C. Given an appropriate weather-proof enclosure, this TI Design system is suited for both indoor and outdoor use.

Immediately following the battery is a low $R_{\text{DS,ON}}$ p-channel MOSFET and a bulk capacitor. The P-channel MOSFET prevents damage to the hardware if the coin cell battery is inserted backwards while minimizing the forward voltage drop in normal operation. The bulk capacitor is sized to prevent too much voltage droop, particularly during the transitions into the MCU on-state for radio transmissions.

1.2 Key System Specifications

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SPECIFICATION</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gas sensor</td>
<td>Figaro TGS5342 (electrochemical type)</td>
<td>Section 1.1.5</td>
</tr>
<tr>
<td>Bluetooth antenna</td>
<td>Inverted F PCB antenna</td>
<td>Section 2.4</td>
</tr>
<tr>
<td>Input power source</td>
<td>CR2032 lithium-ion coin cell battery (3.0 V nominal voltage)</td>
<td>Section 1.1.7</td>
</tr>
<tr>
<td>Beacon frequency</td>
<td>Firmware will broadcast BLE beacon once every 5 minutes by default</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Visual indicator</td>
<td>Two LEDs used to indicate sensor malfunction and high gas concentration</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Calibration</td>
<td>Gas sensor sensitivity and transimpedance amplifier gain programmable through UART interface</td>
<td>Section 2.5 and Section 3.4</td>
</tr>
<tr>
<td>Average standby-state current consumption</td>
<td>1.07 $\mu$A</td>
<td>Section 4.1.1 and Section 4.2.1</td>
</tr>
<tr>
<td>Estimated battery life</td>
<td>&gt; 10 years</td>
<td>Section 4.2.1</td>
</tr>
<tr>
<td>Radio transmission range</td>
<td>&gt; 54 meters</td>
<td>Section 4.1.4 and Section 4.2.4</td>
</tr>
<tr>
<td>Operating conditions</td>
<td>50°C ambient temperature with 40% ± 10% relative humidity</td>
<td>Section 4.1.3 and Section 4.2.3</td>
</tr>
<tr>
<td>Gas detection range</td>
<td>0 to 1000 ppm</td>
<td>Section 4.1.3 and Section 4.2.2</td>
</tr>
<tr>
<td>Form factor</td>
<td>1.7 $\times$ 4.1 in (43.18 $\times$ 104.14 mm)</td>
<td>Section 5</td>
</tr>
</tbody>
</table>
1.3 Block Diagram

![Figure 1. Wireless CO Sensor System Block Diagram](image-url)

1.4 Highlighted Products

The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design features the following devices:

- **LPV811 (Section 1.4.1):** NanoPower, CMOS input, rail-to-rail I/O operation amplifier
- **TLV3691 (Section 1.4.2):** NanoPower, CMOS input, rail-to-rail input comparator
- **CC2650 (Section 1.4.3):** SimpleLink™ multi-standard 2.4-GHz ultra-low-power wireless MCU
- **TPL5111 (Section 1.4.4):** Ultra-low-power timer with MOS driver and MOSFET power ON
- **TMP103 (Section 1.4.5):** Low-power, digital temperature sensor with two-wire interface

For more information on each of these devices, see their respective product folders at [www.TI.com](http://www.TI.com).
1.4.1 LPV811

The LPV811 is an ultra-low-power precision operational amplifier family for “Always ON” sensing applications in battery powered wireless and low power wired equipment. With 8 kHz of bandwidth from 425 nA of quiescent current and a trimmed offset voltage to under 370 µV, the LPV811 amplifiers provide the required precision while minimizing power consumption in equipment such as gas detectors and portable electronic devices where operational battery-life is critical.

In addition to being ultra-low-power, the LPV811 amplifier has CMOS input stages with fempto-amp bias currents which reduces errors commonly introduced in transimpedance amplifier (TIA) configurations with megohm feedback resistors and high source impedance source applications. The LPV811 amplifiers also feature a negative-rail sensing input stage and a rail-to-rail output stage that swings within millivolts of the rails, maintaining the widest dynamic range possible. Likewise, EMI protection is designed into the LPV811 in order to reduce system sensitivity to unwanted RF signals from mobile phones, WiFi, radio transmitters, and tag readers.

The LPV811 amplifier operate with a single supply voltage as low as 1.6V, ensuring continuous performance in low battery situations over the extended temperature range of -40°C to 125°C. The single and dual channel versions are available in industry standard 5-pin SOT-23 package.

Features:
- Nanopower Supply Current: 425 nA/channel
- Offset Voltage: 370 µV (max)
- TcVos: 1 µV/°C
- Gain-Bandwidth: 8 kHz
- Unity-Gain Stable
- Low Input Bias Current: 100 fA
- Wide Supply Range: 1.6 V to 5.5 V
- Rail-to-Rail Output
- No Output Reversals
- EMI Protection
- Temperature Range: –40°C to 125°C
- Industry Standard 5-pin SOT-23 Packages

1.4.2 TLV3691

The TLV3691 offers a wide supply range, low quiescent current 150 nA (maximum), and rail-to-rail inputs. All of these features come in industry-standard and extremely small packages, making this device an excellent choice for low-voltage and low-power applications for portable electronics and industrial systems.

Available as a single channel, the low-power, wide supply, and temperature range makes this device flexible enough to handle almost any application from consumer to industrial. The TLV3691 is available in SC70-5 and 1-mm×1-mm DFN-6 packages. This device is specified for operation across the expanded industrial temperature range of –40°C to 125°C.

Features:
- Low quiescent current: 75 nA
- Wide supply:
  - 0.9 to 6.5 V
  - ±0.45 to ±3.25 V
- MicroPackages: DFN-6 (1 mm × 1 mm), 5-pin SC70
- Input common-mode range extends 100 mV beyond both rails
- Response time: 24 µs
- Low input offset voltage: ±3 mV
- Push-pull output
- Industrial temperature range: –40°C to 125°C
1.4.3 CC2650

The CC2650 is a wireless MCU targeting Bluetooth, ZigBee® and 6LoWPAN, and ZigBee RF4CE remote control applications.

The device is a member of the CC26xx family of cost-effective, ultralow power, 2.4-GHz RF devices. Very low active RF and MCU current and low-power mode current consumption provide excellent battery lifetime and allow for operation on small coin cell batteries and in energy-harvesting applications.

The CC2650 device contains a 32-bit ARM® Cortex®-M3 processor that runs at 48 MHz as the main processor and a rich peripheral feature set that includes a unique ultralow power sensor controller. This sensor controller is ideal for interfacing external sensors and for collecting analog and digital data autonomously while the rest of the system is in sleep mode. Thus, the CC2650 is ideal for applications within a whole range of products including industrial, consumer electronics, and medical.

The BLE controller and the IEEE 802.15.4 MAC are embedded into ROM and are partly running on a separate ARM Cortex-M0 processor. This architecture improves overall system performance and power consumption and frees up flash memory for the application.

The Bluetooth and ZigBee stacks are available free of charge from www.TI.com.

Features:

- **Microcontroller**
  - Powerful ARM Cortex-M3
  - EEMBC CoreMark® score: 142
  - Up to 48-MHz clock speed
  - 128KB of in-system programmable flash
  - 8KB of SRAM for cache
  - 20KB of ultra-low-leakage SRAM
  - 2-pin cJTAG and JTAG debugging
  - Supports over-the-air (OTA) upgrade

- **Ultra-low-power sensor controller**
  - Can run autonomous from the rest of the system
  - 16-bit architecture
  - 2KB of ultra-low-leakage SRAM for code and data

- **Efficient code size architecture, placing drivers, BLE controller, IEEE 802.15.4 MAC, and Bootloader in ROM**

- **RoHS-compliant packages:**
  - 4-mm × 4-mm RSM VQFN32 (10 GPIOs)
  - 5-mm × 5-mm RHB VQFN32 (15 GPIOs)
  - 7-mm × 7-mm RGZ VQFN48 (31 GPIOs)

- **Peripherals:**
  - All digital peripheral pins can be routed to any GPIO
  - Four general-purpose timer modules (eight 16-bit or four 32-bit timers, PWM each)
  - 12-bit ADC, 200-ksamples/s, 8-channel analog MUX
  - Continuous time comparator
  - Ultralow-power analog comparator
  - Programmable current source
  - UART
  - 2× SSI (SPI, Microwire, TI)
  - I²C
  - I²S
  - Real-time clock (RTC)
System Overview

- AES-128 security module
- True random number generator (TRNG)
- 10, 15, or 31 GPIOs, depending on package option
- Support for eight capacitive-sensing buttons
- Integrated temperature sensor

• External system:
  - On-chip internal DC-DC converter
  - Very few external components
  - Seamless integration with the SimpleLink™ CC2590 and CC2592 range extenders
  - Pin compatible with the SimpleLink CC13xx in 4-mm × 4-mm and 5-mm × 5-mm VQFN packages

• Low power
  - Wide supply voltage range
    - Normal operation: 1.8 to 3.8 V
    - External regulator mode: 1.7 to 1.95 V
  - Active-mode RX: 5.9 mA
  - Active-mode TX at 0 dBm: 6.1 mA
  - Active-mode TX at 5 dBm: 9.1 mA
  - Active-mode MCU: 61 µA/MHz
  - Active-mode sensor controller: 8.2 µA/MHz
  - Standby: 1 µA (RTC running and RAM/CPU retention)
  - Shutdown: 100 nA (wake up on external events)

• RF section:
  - 2.4-GHz RF transceiver compatible with BLE 4.2 specification and IEEE 802.15.4 PHY and MAC
  - Excellent receiver sensitivity (–97 dBm for BLE and –100 dBm for 802.15.4), selectivity, and blocking performance
  - Link budget of 102 dB or 105 dB (BLE/802.15.4)
  - Programmable output power up to 5 dBm
  - Single-ended or differential RF interface
  - Suitable for systems targeting compliance with worldwide radio frequency regulations
    - ETSI EN 300 328 (Europe)
    - EN 300 440 Class 2 (Europe)
    - FCC CFR47 Part 15 (US)
    - ARIB STD-T66 (Japan)

• Tools and development environment
  - Full-feature and low-cost development kits
  - Multiple reference designs for different RF configurations
  - Packet sniffer PC software
  - Sensor controller studio
  - SmartRF™ Studio
  - SmartRF Flash Programmer 2
  - IAR Embedded Workbench® for ARM
  - Code Composer Studio™ (CCS)
1.4.4 TPL5111

The TPL5111 nanotimer is a low power system timer, ideal for power gating in duty cycled or battery powered applications. Consuming only 35 nA, the TPL5111 can be used to enable and disable the power supply for a micro-controller or other system device, drastically reducing the overall system stand-by current during the sleep time. This power saving enables the use of significantly smaller batteries and makes the TPL5111 well suited for energy harvesting or wireless sensor applications. The TPL5111 provides selectable timing intervals from 100 ms to 7200 s. In addition, the TPL5111 has a unique one-shot feature where the timer will only assert its enable pulse for one cycle. The TPL5111 is available in a 6-pin SOT23 package.

Features:
• Selectable time intervals: 100 ms to 7200 s
• Timer accuracy: 1% (typical)
• Current consumption at 2.5 V: 35 nA (typical)
• Resistor selectable time interval
• Manual power-on input
• One-shot feature
• Supply voltage range: 1.8 to 5.5 V

1.4.5 TMP103

The TMP103 is a digital output temperature sensor in a four-ball wafer chip-scale package (WCSP). The TMP103 is capable of reading temperatures to a resolution of 1°C.

The TMP103 features a two-wire interface that is compatible with both I2C and SMBus interfaces. In addition, the interface supports multiple device access (MDA) commands that allow the master to communicate with multiple devices on the bus simultaneously, eliminating the need to send individual commands to each TMP103 on the bus.

Up to eight TMP103s can be tied together in parallel and easily read by the host. The TMP103 is especially suitable for space-constrained, power-sensitive applications with multiple temperature measurement zones that must be monitored.

The TMP103 is specified for operation over a temperature range of –40°C to 125°C.

Features:
• Multiple Device Access (MDA):
  – Global Read/Write Operations
• I2C and SMBus-Compatible Interface
• Resolution: 8 bits
• Accuracy: ±1°C typical (–10°C to 100°C)
• Low quiescent current:
  – 3-μA active \( I_Q \) at 0.25 Hz
  – 1-μA shutdown
• Supply range: 1.4 to 3.6 V
• Digital output
• 4-ball WCSP (DSBGA) package
2 System Design Theory

The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design measures carbon monoxide concentration by monitoring the current output of an electrochemical carbon monoxide sensor. Because the sensor outputs a very small current, it must be converted to a voltage, amplified to a reasonable signal level, and at the same time filtered in order to remove noise and minimize false trigger events. The amplified analog output is converted to a digital signal by a comparator function whose output can be used as an interrupt to the wireless MCU to save power by only waking up the MCU when it is needed. The analog output can also be directly sampled by the wireless MCU’s internal ADC. Software can convert the sampled value into an equivalent carbon monoxide concentration through a simple formula. The following sections discuss the details of the design for the different circuit sections that make up the design’s overall subsystem.

2.1 Gas Sensor Basic Theory

The following sections provide some background information on CO sensors and the analog circuitry required to operate them.

2.1.1 Basic Transimpedance Amplifier Circuit

An electrochemical gas sensor generates a current linearly proportional to a gas concentration through a series of chemical reactions. The gas sensing layer of a two-terminal electrochemical sensor consists of a working electrode and a counter electrode separated by an alkaline electrolyte mixture. In the case of a CO sensor, as CO gas reaches the sensing layer, electrons are generated from the reaction of CO and anions in the electrolyte. As shown in Figure 2, current flows between working and counter electrodes when an electrical path is created between them. Since there is a linear relationship between the current and the gas concentration, the sensor can be calibrated using a known gas concentration, and other gas concentrations can be derived from the output of the sensor.

![Figure 2. Electrochemical Gas Sensor Operating Principle](image)
The basic transimpedance circuit for amplifying and filtering the output current of a gas sensor is shown in Figure 3. When the gas sensor is exposed to CO gas, current flows from the working electrode to the counter electrode. The transimpedance amplifier converts the current of the sensor to a voltage with a gain set by the feedback resistor RF. The combination of RF and CF set the upper limit on a low-pass filter. The resistor RL is sometimes recommended by CO sensor manufacturers to add stability to the circuit when resistance is too low. The recommended value for RL is taken from the CO sensor datasheet.

![Figure 3. Basic Transimpedance Circuit for Gas Sensor](image)

The output current of electrochemical sensors can vary with ambient temperature. Applications which require higher accuracy readings under a wide range of operating temperatures can adjust the sensor reading using a temperature correction table in software. The sensor’s susceptibility to temperature can be derived from the sensor’s datasheet.
2.1.2 Sensor Polarization

A sensor can become polarized when it is stored a long time without a connection between the working and counter electrodes. A polarized sensor can take a minutes or hours to stabilize after it is connected to the operating circuit.

A short circuit (or a resistance less than 1 kΩ) must be kept between the sensor electrodes when power is removed from the system to prevent the sensor from becoming polarized. There are several methods to achieve this. As shown in Figure 4, this TI Design uses a p-channel JFET connected across the sensor with its gate connected to the system voltage, VCC. When system power is removed, the JFET turns on creating a short between the working and counter electrodes. When system power is applied, the JFET turns off and the current from the sensor passes to the transimpedance amplifier (TIA).

![Figure 4. Sensor Anti-Polarization Technique Using P-Channel JFET](image)

When selecting the p-channel JFET, the maximum gate-to-source cutoff voltage, $V_{GS\text{off}}$, must be carefully considered so that the JFET does not turn on during normal operation. The $V_{GS\text{off}}$ of the JFET must be greater than the minimum operating system voltage.

This TI Design uses the MMBFJ270 JFET from Fairchild with the gate connected to the battery voltage to keep the sensor from becoming polarized. The maximum $V_{GS\text{off}}$ of 2.0 V ensures the JFET remains off even when the battery starts to lose charge.
2.1.3 Sensor Self-Check

The functionality of the gas sensor must be continuously monitored such that any failures can be signaled and reported to the host. This TI Design implements a modified version of the self-check circuit described by Figaro in the TGS5342 CO sensor technical documentation.

The self-check feature consists of driving a small test current (approximately 1 µA) into the sensor for a short amount of time (approximately four to five seconds) while the sensor is disconnected from the TIA, then monitoring the sensor response after the test current is removed. By analyzing the sensor response to the test current, the MCU can determine when the sensor is operating normally and also several fail conditions such as a short-circuit, an open-circuit, and a loss of sensitivity.

In this TI Design, the self-check feature is controlled by the MCU through one of its I/O pins (see Figure 9 in Section 2.2). To initiate the test, the MCU drives its I/O pin to a logic high. This action causes the p-channel JFET Q2 to turn off, thereby disconnecting the sensor from the TIA. The I/O pin sources the test current directly to the sensor through the resistor R5. To stop the test current, the MCU drives its I/O pin low, at which point the JFET turns on and sensor is once again connected to the TIA.

This TI Design uses the MMBFJ270 JFET from Fairchild for the self-check circuit. The MMBFJ270 has a maximum gate-to-source cutoff voltage, \( V_{GS\text{off}} \), of 2.0 V, which can be met by the minimum \( V_{OH} \) of 2.68 V of the MCU I/O pins. The value of R5 was chosen to drive approximately 1 µA of current into the sensor assuming a minimum \( V_{OH} \) of 2.68 V.

Figure 5 shows a “normal” sensor response after the test current has been applied for five seconds and removed. The MCU monitors the output voltage of the TIA in the second after the test current is removed. The sensor and TIA circuit are deemed operational if the TIA output voltage is greater than 2.3 V.

![Figure 5. Normal Sensor Response to Test Current](image-url)
**Figure 6** shows the sensor response when the sensor is operating normally. In this case, the sensor is exposed to a small amount of CO gas, hence the TIA output voltage is greater than 0 V. Note that the sensor response is like the case shown in **Figure 5**, except that the TIA output settles down the voltage corresponding to the CO gas concentration instead of 0 V.

![Figure 6](image1)

**Figure 6. Normal Sensor Response to Test Current (With CO Gas)**

**Figure 7** shows the sensor response when the sensor is in an open-circuit condition. In this case, there is no output from the TIA during or after the test pulse is applied.

![Figure 7](image2)

**Figure 7. Sensor in Open-Circuit**
Figure 8 shows the sensor response when the sensor is in a short-circuit condition. In this case there is a small voltage at the output of the TIA before and after the test pulse is applied. During the test pulse, the TIA output voltage goes to either the V+ or the V– rail of the TIA op-amp, in this case the output goes to the V– rail (GND).

When the sensor becomes shorted, the short will essentially create a non-inverting amplifier with the $R_{DS_{on}}$ of Q2 acting as the gain resistor and RF1 as the feedback resistor. The voltage offset of the TIA op amp will be amplified and drive the TIA output. Because the voltage offset will vary across different op amps, the TIA output voltage will also vary.

![Figure 8. Sensor in Short-Circuit](image)

The difference between a "normal" sensor (Figure 5 and Figure 6), an open sensor (Figure 7), and a shorted sensor (Figure 8) can be used by firmware to identify a working sensor from a non-working sensor. However, note that the TIA response of an open sensor a shorted sensor can look very similar. Therefore, it is not possible to distinguish between the short and open sensor conditions.

Note that the sensor will take some time to recover after the test current is applied, with a longer period if the test current is applied for a longer period of time. CO gas sampling will be unreliable and unavailable during this period of time. Also, system power will increase during sensor test, reducing battery life. For these reasons, the period between sensor tests must be maximized as much as possible. The firmware used in this TI Design allows 30 seconds for the sensor to recover after the test current is applied and the sensor is tested every 5 minutes. See Section 4.2.1.1 and Section 4.2.1.5 for more information on system power consumption during sensor testing.
2.2 Analog Signal Path

The analog signal conditioning section is shown in the schematic in Figure 9. The output current from the gas sensor is passed through a TIA with a low-pass filter. Following the TIA is a comparator designed to generate an interrupt to the MCU when a certain gas concentration has been reached. The p-channel JFETs Q1 is used to prevent the sensor from becoming polarized and Q2 is used by the MCU to test the sensor. Both Q1 and Q2 are discussed further in Section 2.1.2 and Section 2.1.3.

![Figure 9. CO Sensor Analog Signal Path Schematic](image)

2.2.1 TIA Design

There are many circuit topologies available to implement a TIA stage. The choice ultimately depends on the performance requirements of the overall system. Because of the slow response of the CO sensor to changes in gas concentration, high bandwidth is not required; this allows the use of a low-bandwidth operational amplifier with a 0-V bias. Another key aspect for this application is low input offset voltage on the operational amplifier to prevent voltage shifts due to the internal resistance of the CO sensor.

The TIA stage amplifies the output of the sensor and implements a low-pass filter. The gain of the TIA is $1.78 \times 10^6 \text{ V/A}$ was selected to maximize the output signal for the target gas concentration range (0 to 1000 ppm) while staying within the limits of the ADC input voltage limits on the MCU. The chosen cutoff frequency for the low-pass filter is 0.89 Hz. The cutoff frequency depends on the noise in the system and required response time to changing gas concentrations. Equation 1 and Equation 2 show the gain and cutoff frequency for the TIA stage.

\[
A_{\text{TIA}} = \frac{V_{\text{OUT}}}{i_s} = RF1 = 1.78 \times 10^6 \text{ V/A} \tag{1}
\]

\[
f_{\text{high}} = \frac{1}{2\pi \times RF1 \times CF1} = \frac{1}{2\pi \times 1.78 \text{ M}\Omega \times 0.1 \mu\text{F}} = 0.89 \text{ Hz} \tag{2}
\]

In Equation 1, $V_{\text{OUT}}$ is the output of U1 and $i_s$ is the sensor current.
With a maximum sensitivity of 1.4 nA/ppm specified by the TGS5342 sensor, the output voltage $V_{\text{OUT}}$ of the TIA will be approximately 2.49 V at a temperature of 20°C. At a temperature of 60°C, the current output of the TGS5342 sensor increases by a factor of approximately 1.15, hence $V_{\text{OUT}}$ will increase to approximately 2.87 V. The calculation for $V_{\text{OUT}}$ at these two temperatures is shown in Equation 3, Equation 4, and Equation 5.

\begin{align*}
V_{\text{OUT}} &= \text{GasCon} \times \text{Sensitivity} \times \text{TempCorr} \times A_{\text{TIA}} \\
V_{\text{OUT}} (20^\circ\text{C}) &= 1000 \text{ppm} \times \frac{1.4 \text{nA}}{\text{ppm}} \times 1.0 \times \frac{1.78 \times 10^6 \text{V}}{A} \approx 2.49 \text{ V} \\
V_{\text{OUT}} (60^\circ\text{C}) &= 1000 \text{ppm} \times \frac{1.4 \text{nA}}{\text{ppm}} \times 1.15 \times \frac{1.78 \times 10^6 \text{V}}{A} \approx 2.87 \text{ V}
\end{align*}

In Equation 3, GasCon is the target gas concentration, Sensitivity is the sensitivity of the gas sensor (expressed in nA/ppm), TempCorr is the temperature correction factor (a unit-less number taken from the sensor datasheet), and $A_{\text{TIA}}$ is the gain of the transimpedance amplifier (expressed in V/A).

### 2.2.2 Comparator Design

The comparator circuit shown in Figure 9 converts the analog output of the TIA to a digital signal, which is used as an interrupt to the MCU to tell it when the CO level has reached a specific level. The resistor divider $R4$ and $R6$ sets up the threshold that determines the CO level at which the MCU will be interrupted.

Capacitor $C8$ is necessary to stabilize the threshold voltage to prevent chatter at the output of the comparator. This capacitor does not need to be a large value due to the large resistors being used in the resistor divider, but it must be low ESR and low leakage with ceramic being preferred.

This reference design uses the TLV3691 comparator due to its ultra-low supply current requirements. The TLV3691 comparator also has rail-to-rail input capability with an input common-mode range that exceeds the supply rails by 100 mV. This is not required for this design, but it does allow the ability to maximize the adjustment range of the comparator threshold.

The comparator output will be high when the CO level is below the threshold. When the CO level reaches the threshold, the comparator output will go low.

The comparator threshold is set by adjusting the voltage divider created by $R4$ and $R6$. In this TI Design, $R6$ is a potentiometer, which allows for easy modification.

To adjust the comparator threshold, follow these steps. First, identify the gas concentration at which the comparator should trigger. Second, use Equation 6 to derive the required output voltage, $V_{\text{THRESH}}$, of the voltage divider.

\begin{equation}
V_{\text{THRESH}} = V_{\text{OUT}} = \text{GasCon} \times \text{Sensitivity} \times \text{TempCorr} \times A_{\text{TIA}}
\end{equation}

In Equation 6, GasCon is the target gas concentration, Sensitivity is the sensitivity of the gas sensor (expressed in nA/ppm), TempCorr is the temperature correction factor (a unit-less number taken from the sensor datasheet), and $A_{\text{TIA}}$ is the gain of the TIA (expressed in V/A). Note that the sensitivity of the TGS5342 CO sensor is printed directly below the bar code on the sensor. For example, a code of “1011” must be interpreted as 1.011 nA/ppm.

Lastly, Equation 7 can be used to obtain the value for $R6$.

\begin{equation}
R11 = R9 \times \frac{V_{\text{THRESH}}}{V_{\text{BATT}} - V_{\text{THRESH}}}
\end{equation}

For example, Equation 8 and Equation 9 calculate the value of $R6$ for a comparator threshold of 65 ppm. The calculation uses a temperature correction of 0.85, which corresponds to the lowest operating temperature of 0°C.

\begin{align*}
V_{\text{THRESH}} (0^\circ\text{C}) &= V_{\text{OUT}} (0^\circ\text{C}) = 65 \text{ ppm} \times \frac{1.011 \text{nA}}{\text{ppm}} \times 0.85 \times \frac{1.78 \times 10^6 \text{V}}{A} \approx 99.4 \text{ mV} \\
R11 &= 22 \text{M}\Omega \times \frac{99.4 \text{ mV}}{3.0 \text{ V} - 99.4 \text{ mV}} \approx 754 \text{ k}\Omega
\end{align*}
Note that at higher temperatures, the comparator will trigger at CO concentrations lower than 65 ppm. However, the MCU firmware will calculate the true CO concentration by adjusting for temperature. Also, a sensor with lower sensitivity will generate a lower \( V_{\text{OUT}} \) at 65 ppm. For this reason, in this TI Design R6 is a variable resistor, which can be adjusted on a per board basis to account for the variations in sensor sensitivity values.

### 2.3 Power Supply Design

Because of the increasing battery impedance over the life of the battery supply and the low power supply rejection of the CO sensor, it is important to design the power supply network to prevent current spikes generated by the MCU from causing false triggers through the analog signal path. While the algorithm implemented in firmware helps to filter such problems, this unwanted power supply feedback loop can become an issue. Ideally, the sensor supply would be regulated to break this loop; however, in this design the extra quiescent current of a regulator would reduce battery life, so other methods were explored.

Figure 10 shows a simplified schematic of the power supply network. The PMOS transistor is used in place of the traditional Schottky diode for reversed battery protection. Because the peak currents are in the 10-mA range when the radio transmits, using a low \( R_{\text{DS\_ON}} \) PMOS provides a much lower voltage drop compared to a Schottky diode, which helps to maximize battery life by allowing the battery to decay to a lower voltage before the circuit is no longer able to function (for more on this technique, see SLVA139).

![Figure 10. CO Sensor Simplified Power Supply Network Schematic](image)

Capacitor C14 supplies the circuit during periods of high and fast peak current demand, which helps to maximize the battery capacity and minimize voltage droop on the power supply rail, especially as the battery approaches its end of life and its internal impedance increases (represented by \( R_{\text{int}} \) in Figure 10). The calculation for C14 is provided in Equation 10. For more details on this calculation and the effects of high current peaks on battery life and capacity, see White Paper SWRA349.

\[
C_{14} = \frac{\Delta Q}{V_{\text{MAX}} - V_{\text{MIN}}}
\]

(10)

where

- \( \Delta Q = \frac{Q_{\text{dis}}}{R_{\text{int}}} \cdot t_{\text{tot}} \)
- \( Q_{\text{dis}} = \sum i_n \cdot t_n \)

\( V_{\text{MAX}} \) is the voltage across the capacitor at the start of the current pulse at the end of the battery’s life, and \( V_{\text{MIN}} \) is the circuit operating minimum. \( V_{\text{MAX}} \) is taken to be 2.698 V assuming an unloaded end of life battery voltage of 2.7 V (\( V_P \)).
Based on the power consumption characterization presented in Section 4.2.1, the TI Design experiences a period of high-current consumption at the start of the test state and during a packet transmit. The load profiles based on these two events are shown in Figure 11 and Figure 12.

![Figure 11. Power Profile During Startup Period](image1)

![Figure 12. Power Profile During Packet Transmit Period](image2)

Based on these two profiles, two different values for capacitor C14 can be calculated using Equation 10:

\[ C_{14\text{ (Startup)}} = \frac{7.0 \text{ mA} \times 5 \text{ ms} + 2 \text{ mA} \times 46.2 \text{ ms} - \frac{2.0 \text{ V}}{1 \text{k}\Omega} \times 51.2 \text{ ms}}{2.698 \text{ V} - 2.0 \text{ V}} = 35.8 \mu\text{F} \]  
\[ C_{14\text{ (Packet)}} = \frac{10.0 \text{ mA} \times 4 \text{ ms} - \frac{2.0 \text{ V}}{1 \text{k}\Omega} \times 4.0 \text{ ms}}{2.698 \text{ V} - 2.0 \text{ V}} = 45.8 \mu\text{F} \]  

This design uses \( C_{14} = 100 \mu\text{F} \) and additional decades of capacitors in parallel for improved impedance at higher frequencies. The time required to recharge the composite \( C_{14} \) capacitor after the high current event is given in Equation 13.

\[ T = R_{\text{int}} \times C_{14\text{ comp}} \times \ln \left( \frac{V_{P} - V_{\text{MIN}}}{V_{P} - V_{\text{MAX}}} \right) = 1 \text{k}\Omega \times 111.11 \mu\text{F} \times \ln \left( \frac{2.7 \text{ V} - 2.0 \text{ V}}{2.7 \text{ V} - 2.698 \text{ V}} \right) \approx 0.65 \text{s} \]

The events shown in Figure 11 and Figure 12 are separated by at least 5 seconds (the time during which the test pulse is driven into the CO sensor). Equation 13 shows that the capacitor will be sufficiently recharged to support the second pulse of high-current.

### 2.4 Wireless Network Design

The CC2650 wireless MCU does not retain its state or have any control over when it wakes up once it enters its shutdown mode. For this reason, this TI Design is intended to be used in a star network configuration. This means that each sensor end-node connects directly to a central receiver, which receives the data from each end-node, and then performs any necessary processing and, if needed, connection to the cloud. This TI Design is not intended to be used in smart mesh networks.

The firmware for this TI Design sends out non-connectable advertisement packets that contain several bytes of data containing, CO concentration, battery voltage, temperature, and status flags, among other things. The firmware can be configured to send additional information for debug purposes. For more information, see Section 2.5.

The antenna on this TI Design is the inverted F PCB antenna for 2.4-GHz transceivers and transmitters. See the application note DN0007 (SWRU120) for more details about layout and performance.
2.5 Firmware Control

Figure 13 describes the firmware operation in this TI Design. The firmware first starts by checking the status of the user button S1. If the user button is depressed, the firmware enters its calibration procedure. If the user button is not depressed, the firmware enters its standby state. The CC2650 will be in shutdown mode while the firmware is in the standby state to conserve power.

The firmware will stay in the standby state until a wakeup interrupt is received from either the comparator or the system nano-power system timer. If the wakeup source was the system timer, the firmware will start its sensor test. If the wakeup source was the comparator, the firmware will enter its pre-alarm state.

In the pre-alarm state, the firmware will monitor the CO level every second, using a 10-second moving average to stabilize the CO sensor output. The CO level is calculated using Equation 14, where GasCon is the target gas concentration, $V_{OUT}$ is the output voltage of the TIA circuit, Sensitivity is the sensitivity of the gas sensor (expressed in nA/ppm), TempCorr is the temperature correction factor (unit-less), and $A_{TIA}$ is the gain of the TIA circuit (expressed in V/A). The values for Sensitivity and $A_{TIA}$ are stored in the MCU flash during system calibration and the TempCorr values are stored as a table in the firmware source code.

$$\text{GasCon} = \frac{V_{OUT} \times \text{TempCorr}}{\text{Sensitivity} \times A_{TIA}}$$  \hspace{1cm} (14)

The firmware moves into its alarm state if the CO concentration stays above a concentration of 65 ppm for the minimum response time as indicated in Table 2. The firmware monitors the CO concentration every second and will stay in the alarm state until the CO concentration drops below 65 ppm. A packet will be sent to the host every minute to indicate the alarm state has been reached. A system LED will also be toggled to give a visual indication of the alarm condition.
As previously mentioned, the firmware will test the sensor and TIA circuit periodically and enter a trouble state if an error condition is detected (see Figure 14). The firmware tests the sensor and TIA circuit through the use of the self-check circuit described in Section 2.1.3. If no error is detected, the firmware will allow 30 seconds for the sensor to stabilize, send a packet to the host with the status flags set to "OK", and return to the standby state. If an error is detected, the firmware will transition to the trouble state where it will remain until the system is reset. In the trouble state, the firmware will continuously toggle LED D2 and send a packet to the host with the status flag set to "TROUBLE" every minute.
The calibration procedure allows the user to configure several parameters including the sensor sensitivity and TIA gain used by the firmware when calculating the CO concentration (see Figure 15). All parameters are saved to the MCU flash and are read and used during normal operation. The calibration procedure is initiated after power-up by depressing the user button S1 while releasing the system from reset.

All communication between the firmware and user is carried out through the UART interface of the MCU. A serial connection is required to communicate with the firmware during the calibration routine (see Section 3.4).

From the calibration routine, the user can trigger a CO level measurement using the stored sensitivity and TIA gain parameters. Because the UART lines are shared with the I2C lines going to the TMP103 temperature sensor, a temperature reading is not possible in this case. However, the user has the option to specify a temperature. This test temperature is used to select a temperature correction factor during the CO level calculation. The result of the calculation is printed through the serial console.

When the user exits the calibration routine the firmware will transition into a continuous sampling mode. In this mode, the firmware will transmit a packet every second containing the CO level and temperature (see Table 3). A hardware reset is required to exit the continuous sampling mode.

Figure 14. Sensor Test Procedure
As indicated previously, the CC2650 broadcasts packets at different times to communicate with a host. The format of the status packet is shown in Table 3 and described in Table 4. The firmware can also be configured through a pre-compiler statement to transmit additional debug information as shown in Table 5 and described in Table 6.

### Table 3. Status Packet Contents

<table>
<thead>
<tr>
<th>BYTE 0 AND 1</th>
<th>BYTE 2</th>
<th>BYTE 3</th>
<th>BYTE 4 AND 5</th>
<th>BYTE 6</th>
<th>BYTE 7 AND 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIDA Num</td>
<td>Board ID</td>
<td>Status Flag</td>
<td>Battery Voltage</td>
<td>Temp</td>
<td>Gas Concentration</td>
</tr>
</tbody>
</table>

### Table 4. Status Packet Byte Description

<table>
<thead>
<tr>
<th>BYTE NAME</th>
<th>BYTE NUMBER</th>
<th>RESET VALUE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIDA Num</td>
<td>1:0</td>
<td>0x738</td>
<td>Specifies the TIDA number. By default, these bytes are set to 0x0738, or 756 in decimal.</td>
</tr>
<tr>
<td>Board ID</td>
<td>2</td>
<td>0xFF</td>
<td>Specifies the board ID. This field can be set by the user through the calibration routine.</td>
</tr>
</tbody>
</table>
| Status Flags | 3 | — | Specifies the status of the system.  
  • Bit 0: TROUBLE  
  • Bit 1: ALARM  
  • Bit 2: OK  
  • Bit 3: CAL_ERROR  
  • Bits 4 to 7: Reserved |
### Table 4. Status Packet Byte Description (continued)

<table>
<thead>
<tr>
<th>BYTE NAME</th>
<th>BYTE NUMBER</th>
<th>RESET VALUE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery Voltage</td>
<td>5:4</td>
<td>—</td>
<td>Battery voltage read from MCU internal battery monitor. $V_{\text{BATT}} = \frac{\text{Byte5}<em>{10} \times 256 + \text{Byte4}</em>{10}}{1000}$ (15) For example, when Byte5 = 0x0C and Byte4 = 0x44, the battery voltage is 3.140 V.</td>
</tr>
<tr>
<td>Temp</td>
<td>6</td>
<td>—</td>
<td>Temperature reading from TMP103 temperature sensor in Celsius. For example, 0x1B = 27°C.</td>
</tr>
<tr>
<td>Gas Concentration</td>
<td>8:7</td>
<td>—</td>
<td>Gas concentration calculation in ppm. $\text{GasCon} = \left(\text{Byte8}<em>{10} \times 256\right) + \text{Byte7}</em>{10}$ (16) For example, when Byte8 = 0x00 and Byte7 = 0xC6, the gas concentration is 198 ppm.</td>
</tr>
</tbody>
</table>

### Table 5. Additional Debug Information (If Enabled)

<table>
<thead>
<tr>
<th>BYTE 8 AND 9</th>
<th>BYTE 10 AND 11</th>
<th>BYTE 12 AND 13</th>
<th>BYTE 14 AND 15</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC Value</td>
<td>Sensitivity</td>
<td>Gain</td>
<td>Temp Correction</td>
</tr>
</tbody>
</table>

### Table 6. Additional Debug Information Byte Description

<table>
<thead>
<tr>
<th>BYTE NAME</th>
<th>BYTE NUMBER</th>
<th>RESET VALUE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADC Value</td>
<td>9:8</td>
<td>—</td>
<td>Raw value read from ADC during last CO calculation.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>11:10</td>
<td>0xFFFF</td>
<td>Sensitivity setting used for CO calculations. This value must be set by the user through the calibration routine. $\text{Sensitivity} = \frac{\text{Byte11}<em>{10} \times 256 + \text{Byte10}</em>{10}}{1000}$ (17) For example, when Byte11 = 0x04 and Byte10 = 0x19, the sensitivity is 1.049 nA/ppm.</td>
</tr>
<tr>
<td>Gain</td>
<td>13:12</td>
<td>0xFFFF</td>
<td>Gain setting used for CO calculations. This value must be set by the user through the calibration routine. $\text{Gain} = \frac{\text{Byte13}<em>{10} \times 256 + \text{Byte12}</em>{10}}{1000}$ (18) For example, when Byte13 = 0x06 and Byte12 = 0xF4, the gain is $1.780 \times 10^6$ V/A.</td>
</tr>
<tr>
<td>Temp Correction</td>
<td>15:14</td>
<td>—</td>
<td>Temperature correction used during last CO calculation. This is read from an internal table, indexed by the last temperature reading. $\text{TempCorr} = \frac{\text{Byte15}<em>{10} \times 256 + \text{Byte14}</em>{10}}{1000}$ (19) For example, when Byte15 = 0x04 and Byte14 = 0x0E, the temperature correction is 1.038.</td>
</tr>
</tbody>
</table>
3 Getting Started Hardware and Firmware

3.1 Hardware

Figure 16 shows the hardware for the Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design. The printed circuit board (PCB) is in a 43×104-mm rectangular form factor and comes with 0.5-in nylon standoffs to ensure ease of use while performing lab measurements.

![PCB Diagram]

Figure 16. Low-Power Carbon Monoxide Sensor Reference Design Hardware Description

All the integrated circuits (CC2650, LPV811, and TLV3691), several test points, and jumpers are located on the top side of the PCB. The antenna is also located on the top side of the PCB. The bottom side of the PCB contains the CR2032 coin cell battery holder.

There are two CC2650 pins that have been brought out to header J6 for use during calibration. These pins are configured as UART RX and TX pins during calibration for communication with a host through a serial port.
3.1.1 Jumper Configuration

To facilitate measuring critical parameters and debugging in this reference design, there are several jumpers included. To properly operate the design, these jumpers must be installed correctly.

The jumper configuration for normal operation is as follows:

- J1 = Shorted
- J2 = Shorted
- J6 = Open
- J8 = Open

The jumper configuration to load new firmware on the CC2650 is as follows:

- J1 = Shorted
- J2 = Open
- J6 = Open
- J8 connected to the 10-pin ARM Cortex Debug Connector on the SmartRF06 Evaluation Board (EVM) through a ribbon cable

When connecting to a SmartRF06 EVM, set the source switch to "USB" and short the "VDD to EM" jumper on the EVM. In this configuration, the SmartRF06 EVM provides power to the CC2650. See the SmartRF06 EVM documentation for more information (SWRU321).

When running the calibration routine, the following jumper configuration is as follows:

- J1 = Shorted
- J2 = Shorted
- J6 = Connected to host
- J8 = Open

Jumper J6 brings out the CC2650 UART RX and TX pins. These pins can be used to communicate with a host computer through the use of an external RS-232 transceiver such as the TTL-232R-3V3-PCB from FTDI.

NOTE: Make sure to put the board in calibration mode before connecting an external RS-232 transceiver to connector J6.

3.1.2 Test Point Description

This design includes several test points to monitor critical signals. The following is a brief description of these test points:

- TP1: Output of transimpedance stage and filter, which is also the input to the comparator
- TP2: Comparator output
- TP3: Threshold voltage input to comparator
- TP4, TP5: Ground points for probes or common points for voltage measurements
- TP6: System nano-power timer interrupt output
- TP7: Filtered battery supply input to the DC-DC converter in the CC2650
- TP8: Filtered DC-DC converter output from the CC2650
3.1.3 Battery Requirements

Only insert Energizer CR2032VP Lithium battery or battery with equivalent specifications:

- CR2032 UL certified battery
- Voltage: 3.0 V
- Min capacity: 240 mAh
- Min discharge rate: 0.19 mA

**NOTE:** Only insert an Energizer CR2032VP Lithium battery or equivalent.

**NOTE:** The battery must be replaced by a trained professional.

3.1.4 Miscellaneous

A sensor can become polarized when it is stored a long time without a connection between the working and counter electrodes. A polarized sensor can take a minutes or hours to stabilize after it is connected to the operating circuit. This TI Design uses a p-channel JFET to short the sensor electrodes when the battery voltage is removed, which prevents the sensor from becoming polarized. However, when installing a new sensor some time must be allowed for the sensor to stabilize. See the sensor datasheet for details on sensor polarization and stabilization time.
3.2 Loading Firmware

The firmware used on this TI Design was developed using TI's CCS software (version 6.1.0). The IAR Embedded Workbench for ARM also supports the CC26xx line of SimpleLink products.

The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J8 to the SmartRF06 EVM (10-pin ARM Cortex Debug Connector, P410). On the SmartRF06 EVM, set the source switch to "USB" and short the "VDD to EM" jumper. In this configuration, the SmartRF06 EVM provides power to the CC2650. See the SmartRF06 EVM documentation for more information (SWRU321). Before powering on the SmartRF06 EVM, configure the jumpers on the TI Design hardware for firmware loading (see Section 3.1). Specifically, make sure the J2 jumper is open on the TI Design hardware.

See Figure 17 for a photo of the correct setup for connecting the TI Design hardware to the SmartRF06 EVM.

After setting up all the hardware, follow these steps to load the new firmware on the TI Design using the SmartRF Flash Programmer 2:

2. Open SmartRF Flash Programmer 2.
3. In the "Connected devices" window, CC2650 should be listed under XDS100v3. If it is not listed, check the power and connection from SmartRF06 to TIDA-00756 and click "Refresh" button to rescan for devices. Highlight the CC2650 device.
4. In the "Main" tab, click the "Single" radio button.
5. **IMPORTANT**: In the "Main" tab, under "Actions", click the "Pages in image" radio button. This will prevent the programmer from erasing any calibration values previously written to flash.
6. Click on "Browse" button and navigate to the TIDA00756-Firmware.out file.

![SmartRF Flash Programmer 2 Configuration](image-url)

Figure 18. SmartRF Flash Programmer 2 Configuration

7. Click on the blue circle play button to flash the firmware image onto the TIDA-00756 board.

The status bar on the bottom of SmartRF Flash Programmer 2 will show if flashing the image was successful.
3.3 Receiving Data Packets

As shown in Section 2.5, this TI Design is programmed to monitor the CO level and periodically evaluate the system status. The CC2650 broadcasts packets at different times to communicate with a host.

Two methods to view the transmitted packets are described in the following subsections.

3.3.1 Receiving Data Packets Using CC2540EMK-USB and SmartRF Protocol Packet Sniffer

To verify the proper operation of the radio transmission, the CC2540EMK-USB CC2540 USB Evaluation Module Kit is used to ‘sniff’ packets using the SmartRF Protocol Packet Sniffer software. After installing the Packet Sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data transmissions:

1. Plug the CC2540EMK-USB into an unused USB port on the computer with the Packet Sniffer software installed.
2. Open the Packet Sniffer software; choose “Bluetooth Low Energy” as the protocol and hit Start.
3. Click on the Radio Configuration tab and verify that “Advertising Channel 39” is selected.
4. Press the Play button on the top toolbar to initiate the packet capture process.

Figure 19. Packet Sniffer Software
5. There will likely be many other packets detected, probably from mobile phones and other devices that use the Bluetooth Smart protocol. To view only the packets sent from the TI Design hardware, it is necessary to apply a display filter. Figure 20 shows a sample display of what will be recorded with no filter applied. The highlighted row shows the desired data packet in the midst of other, undesired data packets.

![Figure 20. Packet Sniffer Software, Filterless Recording](image)

6. The appropriate filter checks for non-connectable advertisement packets with ADV_NONCONN AdvA field equal to 0x265026502650. In the Field Name, select ADV_NONCONN AdvA from the drop down options. Click the "First" button. Modify the filter condition to the correct address, hit "Add", and then click "Apply filter". An example filtered view is shown in Figure 21.

![Figure 21. Packet Sniffer Software, Filtered Recording](image)
7. To export the captured, filtered packets, press the "Saves the current session" button on the toolbar, or pause the packet capture and click File → Save data…; either of these choices prompts to save the displayed data as a packet sniffer data (.psd) file.

8. Convert the .psd file to readable hex values with HexEdit software. A different hex editor can perform this function as well; however, the authors of this guide have not verified any other options.

9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window, click on Document → Display and change the Columns value to "271". Click Edit → Select All and Edit → Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and save the text file. This text file can then be imported into Microsoft® Excel® spreadsheet software for further analysis. For more information on the sniffer data packet format, click Help → User Manual on the packet sniffer software.

3.3.2 Receiving Data Packets using SmartRF06 Evaluation Board and CC2650 Evaluation Module

The second method uses the SmartRF06 Evaluation Board and the CC2650 Evaluation Module hardware to "sniff" the packets using SmartRF Studio. After installing the SmartRF Studio (v2.3.0 at the time of this writing), the procedure to detect the data transmissions is as follows:

1. Connect the CC2650 EVM to the EM header on the SmartRF06 evaluation board.
2. Verify that the following jumpers are populated: P483, P484, P485, and VDD TO EM.
3. Power on the SmartRF06 board.
4. Run the SmartRF Studio software.
5. Click on the Refresh button and verify that CC2650 is listed under the Connected devices window.
6. Click on the "2.4GHz" tab and double click on the CC2650.
7. Select the "BLE mode" radio option.
8. Change the BLE channel to 39 and select the target configuration that matches the CC2650 EVM.
9. Click the "Packet Rx" tab.
10. Check the "Infinite" box and leave all the other options as default.
11. Click the "Start" button.

The SmartRF Studio will capture all BLE advertising packets on channel 39 and display the packet information. Below is an example snapshot.
3.4 Loading Calibration Values

There are two methods for loading calibration values on the TI Design. The first method uses a calibration routine programmed into the TI Design firmware. An external RS-232 transceiver is required to complete this method. The second method uses the Flash Programmer 2 to load the calibration values directly to the flash of the TI Design.

3.4.1 Loading Calibration Values Using Calibration Routine

This TI Design supports a calibration routine through which the user can perform such functions as setting the CO sensor sensitivity and the TIA gain (see Section 2.5). To use the calibration routine, follow these steps:

1. Configure the jumper settings on the board.
   - J1 = Shorted
   - J2 = Shorted
   - J6 = Connected to host through external RS-232 transceiver, for example the TTL-232R-3V3-PCB from FTDI
   - J8 = Open

2. Connect the board to a host PC serial port.

3. Open a serial terminal (for example, Tera Term) on the host PC with the following settings:
   - Baud rate: 115200
   - Data size: 8 bits
   - Stop bits: 1
   - Parity: None
   - Flow Control: None

4. Power the board.
5. Depress the user button S1 while releasing the reset button S2.
6. Follow the prompts on the serial terminal to complete the calibration routine.

NOTE: Make sure to put the board in calibration mode before connecting an external RS-232 transceiver to connector J6.

3.4.2 Loading Calibration Values Using Flash Programmer 2

Follow these steps to load new calibration values on the TI Design hardware using the SmartRF Flash Programmer 2:
2. Open SmartRF Flash Programmer 2.
3. In the "Connected devices" window, CC2650 should be listed under XDS100v3. If it is not listed, check the power and connection from SmartRF06 to TIDA-00756, and click "Refresh" button to rescan for devices. Highlight the CC2650 device.
4. In the "Edit" tab, under "Select memory", click the "Address" radio button, and enter address "E000" and length "5".
5. Click the "Read" button.
6. Update the five bytes with the new calibration values in hex format:
   • Byte 0: Sensitivity MSB
   • Byte 1: Sensitivity LSB
   • Byte 2: Gain MSB
   • Byte 3: Gain LSB
   • Byte 4: Board ID
7. Click the "Write" button.

The status bar on the bottom of SmartRF Flash Programmer 2 will show if flashing the image was successful (see Figure 23).

Figure 23. SmartRF Flash Programmer 2 Configuration for Loading Calibration Values
4 Testing and Results

4.1 Test Setup

The Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design has been characterized to support all of the critical specifications for this subsystem. The following sections describe the test setups for these measurements including the equipment used and the test conditions unless otherwise noted.

4.1.1 Power Consumption

The power consumption measurements for this reference design were critical in estimating battery life. Measurements of supply current were performed on the reference design hardware.

The majority of the time, the system operates in a very low power consumption state, often only consuming nanoamps of current. The test setup for measuring these small currents is illustrated in Figure 24.

The resolution setting of the Agilent 34411A 6½ digit multimeter can place a limit on the amount of instantaneous current flowing to the DUT. This can become a problem because at different points during normal operation the current will jump from the nanoamp range to the milliamp range. For example, when powering on the board, there will be an initial inrush of current to the board. Generally, a resolution of 10 mA is enough to prevent any issues with current limits.

The system will also experience peaks of high current such as those generated during radio transmission and CO sensor tests. The measurement of these intervals involves using a current probe that interfaces to an oscilloscope, which can then be used to trigger on the high current events. This setup is illustrated in Figure 25.
4.1.2 Temperature and Humidity Range

This TI Design was stressed under temperature and relative humidity bias to ensure the design operates as expected under the extremes of the targeted environment.

The environmental chamber used for the temperature and humidity stress was the TestEquity 1000H Temperature/Humidity Chamber with F4 Controller. A total of five reference design PCBs were placed in the chamber: three with new Energizer CR2032 lithium-ion coin cell batteries and two powered with 3.0 V from a benchtop DC power supply. A SmartRF06 EVM with CC2540EM board was placed outside the chamber and connected to a laptop with a USB cable to monitor packets transmitted by the boards during the test.

The reference design PCBs were loaded with firmware, which executed a system test every five minutes and transmitted a packet indicating the system status. A returned status of OK indicated functionality of the sensor, the analog signal path, and the radio. Carbon monoxide was not used during this test; however, the system test ensured that the sensor was functional during and after the test.

Figure 26 and Figure 27 show pictures of the setup used for these temperature and humidity tests.
4.1.3 CO Sensitivity

The sensitivity to carbon monoxide was measured on a reference design PCB using 100-, 200-, and 300-ppm calibration gas. All tests were performed at an ambient temperature of 23°C in a lab with a relative humidity of 50% ± 20%. The PCB was exposed to the temperature and humidity conditions for at least 15 minutes. The PCB was supplied with 3.0 V from a benchtop DC power supply.

The reference design PCB was loaded with firmware specifically modified to calculate the CO concentration every second and transmit the result in a wireless packet. The firmware calculated the CO gas concentration using Equation 14 in Section 2.5, with the sensitivity taken from the code printed on the gas sensor and the gain set to $1.78 \times 10^6$ V/A. A temperature measurement was taken before each calculation and a correction factor was applied using the information in the TGS5342 documentation. All packets were captured using a SmartRF06 EVM as described in Section 3.3.2. The data was ported to Microsoft® Excel® for final analysis.

4.1.4 Wireless RF Range

The range of the wireless 2.4-GHz RF was measured using the CC2540EMK-USB and SmartRF Protocol Packet Sniffer described in Section 3.3.1. For this test, the CC2540EMK-USB remained at a stationary location as the TI Design was moved away from the CC2540EMK-USB. The TI Design was configured to continuously transmit packets every second. The two boards were always in direct view of each other.

4.2 Test Data

NOTE: Unless otherwise noted, the test data in the following sections were measured with the system at room temperature. All of the measurements in this section were measured with calibrated lab equipment.

4.2.1 Power Consumption

Because the primary purpose of this TI Design is to showcase a battery-powered wireless CO sensor, characterization of the system’s power consumption is critical.

As described in Section 2.4, this TI Design can be in one of multiple states during normal operation: Standby, pre-alarm, alarm, and test. Both the duration and the average current of each state are factors in estimating the total battery life of the TI Design system.

This TI Design will remain primarily in the standby state, which is the default state when the CO level is below the specified minimum concentration. It is critical that the power consumption of this state remain as low as possible such that the battery life of the system can be maximized. In this state, the CO sensor, TIA circuit, and comparator will be remain active to continuously monitor the CO concentration. The CC2650 will receive power, but will go into its shutdown mode to minimize power consumption. The TMP103 will be completely powered off. The TPL5111 will remain active to provide a timer interval to the CC2650 for executing periodic system tests.

In the test state, the TIDA-00756 initiates a system test to assess the functionality of the gas sensor and the analog signal chain. The CC2650 will come out of its shutdown mode to carry out the required test functions, but the device will go into its standby state as much as possible to conserve power. Note that the CC2650 cannot use its shutdown mode since all volatile memory and register contents are lost, making it impossible to keep track of the sequence of steps needed to carry out the system test (writing data to MCU flash was discarded as an option to avoid using up flash erase cycles). Once the system test is complete, this TI Design will transmit a packet with the results of the test and transition back into its standby state if everything is normal.

When the CO concentration rises above the specified minimum concentration, the comparator will trigger and the TIDA-00756 will transition from standby state to pre-alarm state. In this state, the CC2650 will remain in its standby mode and will monitor the CO concentration every second. Like the test state, the CC2650 cannot use its shutdown mode in the pre-alarm state. The TMP103 will be powered only long enough to take a temperature measurement such that the CO concentration can be corrected for temperature variations. The CC2650 does not transmit any packets in this state.
In the alarm state, this TI Design will perform all the functions of the pre-alarm state and will additionally transmit a packet to the host every minute and generate a visual indicator by toggling a system LED every second. In this state, the TIDA-00756 will consume the most amount of power.

### 4.2.1.1 Standby and Test State Power Characterization

The standby state current consumption was measured on five separate boards at multiple system voltages. The results of all the measurements are shown in Figure 28. Each measurement was taken over a period of 60 seconds. All boards were allowed to settle for 60 seconds after system power-up before each measurement. As expected, the current consumption increases with increasing system voltage.

![Figure 28. Standby State Current Consumption Across System Voltage](image)

As described in Section 4.2.1, the standby state is interrupted periodically by an interrupt from the system nanopower timer. The TI Design enters the test state during this time to carry out several functions.

The current consumption in the test state changes between microamps and milliamps during this time, making it difficult to measure the total current consumption of the state. However, several high-current events were captured for analysis. Figure 29 captures the high-current event associated with the CC2650 coming out of its shutdown mode. In this case, the high-current consumption is attributed to the MCU reading internal flash memory to load the firmware. Figure 30 captures the high-current consumption due to the transmission of a packet containing the results of the system test.

![Figure 29. Startup Current at the Beginning of Test State](image)

![Figure 30. Transmit Current for Wireless Packet in Test State](image)
The average system current was measured over several minutes such that the TI Design transitioned between the standby state and test state multiple times. This TI Design transitioned to the test state every five minutes. The statistics functions of the Agilent 34411A was used to keep track of the average current over this time. The Agilent 34411A was set to an NPLC of 10 and a 10-mA resolution. The results of the averaging are shown in Table 7.

### Table 7. Standby State Plus Test State Average Current Over Several Minutes

<table>
<thead>
<tr>
<th>VBATT (V)</th>
<th>AVERAGE TOTAL CURRENT (A)</th>
<th>AVERAGE TIME (MIN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.8</td>
<td>1.02E-06</td>
<td>36</td>
</tr>
<tr>
<td>3.0</td>
<td>1.11E-06</td>
<td>35</td>
</tr>
<tr>
<td>2.4</td>
<td>1.09E-06</td>
<td>35</td>
</tr>
</tbody>
</table>

The average current over the range of system voltages from 3.8 V to 2.4 V are used for battery life calculations. This average current for this voltage range is 1.07 μA.

#### 4.2.1.2 Pre-Alarm State Power Characterization

The current consumption in the pre-alarm state was measured on five separate boards at multiple system voltages. The results of all the measurements are shown in Figure 31. Each measurement was taken over a period of 90 seconds.

One observation from Figure 31 is that the system current decreases with increasing system voltage. This is expected since at lower system voltages, the internal DC-DC of the CC2650 must recharge the bypass capacitors more often to maintain a constant supply voltage.

![Figure 31. Pre-Alarm State Current Consumption Across System Voltage](D002)

The average current over the range of system voltages from 3.3 V to 2.4 V are used for battery life calculations. The current numbers from board #61 are used to calculate the average because these represent the worst case from the batch of boards tested. This average current for this voltage range is 7.69 μA.

#### 4.2.1.3 Alarm State Power Characterization

The current consumption in the alarm state was measured on a single board at multiple system voltages. The results of all the measurements are shown in Figure 32. Each measurement was taken over a period of 180 seconds such that multiple packet transmissions were included in the measurement.

As expected, the average current at each system voltage is dominated by the LED current, which is in the milliamp range. The current consumption of other system components and other CC2650 operations average in the microamp range, total. Since the LED toggles on and off, the average alarm state current depends on the LED toggling frequency and on-state duration.
Figure 32. Alarm State Current Consumption Across System Voltage

The average current over the range of system voltages from 3.3 V to 2.4 V are used for battery life calculations. This average current for this voltage range is 525 μA.

### 4.2.1.4 Battery Life Calculations

The main parameters that affect the estimated battery life of the entire system are:

- Capacity rating of the battery in milliamp-hours (mAh)
- State current consumption, average (μA)
- State duration per year (hr/yr)

The firmware supports four basic states: Standby, test, pre-alarm, and alarm. For simplicity, the standby and test states are combined into a single state (see Section 4.2.1.1). Equation 20 describes the estimated battery life of the system:

\[
Battery\ Lifetime(\text{yr}) = \frac{Battery\ Capacity(\text{mAh})}{I_{\text{Standby}}(\mu\text{A}) \times t_{\text{Standby}}(\text{hr/yr}) + I_{\text{PreAlarm}}(\mu\text{A}) \times t_{\text{PreAlarm}}(\text{hr/yr}) + I_{\text{Alarm}}(\mu\text{A}) \times t_{\text{Alarm}}(\text{hr/yr})} \times \text{Derating Factor}
\]  

(20)

The amount of time spent in each state per year depends entirely on the end-use case. However, for the purpose of this TI Design, the following use-case was defined:

- 52 3-second alarms, per year (weekly testing)
- 25 cycles of 5-second alarms, per year (random testing)
- 12 hours of alarm, per lifetime
- 7 days of trouble signal, per lifetime
- System test and beacon every 5 minutes

Using these requirements, the \( t_{\text{PreAlarm}} \) and \( t_{\text{Alarm}} \) times per year can be calculated as follows:

\[
t_{\text{Alarm}} = \frac{(52 \times 3\text{s} + 25 \times 5\text{s})\left(\frac{1\text{hr}}{3600\text{s}}\right)}{1\text{yr}} + \frac{12\text{hr} + (7\text{d})\left(\frac{24\text{hr}}{1\text{d}}\right)}{10\text{yr}}
\]  

(21)

\[
t_{\text{PreAlarm}} = \frac{12\text{hr}}{10\text{yr}} = 1.2\text{hr/yr}
\]  

(22)

**Equation 21** assumes that the TI Design will be placed directly in the alarm state during weekly and random testing although the TI Design firmware does not include a mechanism to go directly into the alarm state. **Equation 21** also includes the 7 days of trouble signal since the power consumption would be very similar to the alarm case. The 12 hours of alarm state and 7 days of trouble state are averaged over the target lifetime of 10 years since these are lifetime requirements and not yearly requirements.
Equation 22 assumes that the firmware will cycle through the pre-alarm state before reaching the alarm state. Finally, in reality the current consumption of 3-second and 5-second alarms will be higher than \( I_{\text{Alarm}} \), the average current consumption the TI Design taken over several minutes during which an LED toggles on and off and packet is transmitted every minute. However, because the duration of the weekly and random tests is very short, the final lifetime calculation changes very little.

Substituting these time numbers and the current numbers derived in the preceding sections, the battery life can be estimated as follows:

\[
\text{Battery Lifetime (yr)} = \frac{240 \text{ mAh}}{1.07 \mu\text{A} \times (8760 \times 1.2 - 18.1) \text{ hr/yr} + (7.69 \mu\text{A} \times 1.2 \text{ hr/yr}) + (525 \mu\text{A} \times 18.1 \text{ hr/yr})} \times 0.85 = 10.82 \text{ yr}
\]

4.2.1.5 System Trade-Offs

Adjusting the interval of the system timer interrupt can lead to increased battery life. As described in Section 4.2.1, the timer interrupt triggers the sensor function, which in itself generates a high-current event due to firmware load from flash, and another due to the transmission of a wireless packet. Increasing the interval of the timer adds more time between test cycles and, in effect, lowers the average current consumption of the combined standby and test state (see Figure 33). The reduced current for these two states will, inversely, increase the battery life (see Figure 34). Note that the current numbers for Figure 33 are theoretical numbers based on test data and information provided in device datasheets. However, measurements performed on hardware were performed as a sanity-check on a few of the data points. All estimates were calculated assuming a \( V_{\text{BATT}} \) of 3.0 V.

![Figure 33. Combined Standby and Test State Average Current versus Timer Interval](image1)

![Figure 34. Battery Life versus Timer Interval](image2)
4.2.2 CO Sensitivity

The sensitivity to carbon monoxide was measured on a reference design PCB using 100-, 200-, and 300-ppm calibration gas. As shown in Figure 35, Figure 36, and Figure 37, the test PCB was able to detect the injection of CO gas with no problems. Note that a 10-second moving average was added after the test using Microsoft Excel for visualization purposes.

Figure 35. 100-ppm CO Level Results

Figure 36. 200-ppm CO Level Results
The data transmitted by the test PCB was analyzed to determine the accuracy of the gas measurement. Microsoft Excel was used to calculate the minimum, maximum, and average readings at each CO concentration level, after discarding data points during which the gas was being injected into the test setup. The maximum percent error was also calculated for each set of data. Table 8 shows the results of these calculations. The results agree with the TGS5342 documentation, which states a maximum error of ±15% is to be expected when using the sensitivity data printed on the gas sensor.

<table>
<thead>
<tr>
<th>TEST</th>
<th>MIN</th>
<th>MAX</th>
<th>AVERAGE</th>
<th>MAX ERROR</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 ppm</td>
<td>99</td>
<td>113</td>
<td>107.3</td>
<td>13.00%</td>
</tr>
<tr>
<td>200 ppm</td>
<td>201</td>
<td>214</td>
<td>207.2</td>
<td>7.00%</td>
</tr>
<tr>
<td>300 ppm</td>
<td>302</td>
<td>316</td>
<td>309.5</td>
<td>5.30%</td>
</tr>
</tbody>
</table>

### 4.2.3 Temperature and Humidity Range

This TI Design was stressed under temperature and relative humidity bias to ensure the design operates as expected under the extremes of the targeted environment. A total of five reference design PCBs were exposed to two temperature and humidity conditions:

- 50°C with a relative humidity of 40% for a total of three hours
- 0°C with a relative humidity of 30% for a total of three hours

In both cases, the environmental chamber was programmed to ramp the temperature from 25°C to the target temperature and humidity at a rate of 1°C per minute, soak at the target temperature and humidity for three hours, and then finally ramp back to 25°C at a rate of 1°C per minute.

All five boards ran a system check every five minutes to assess the functionality of the sensor, the analog signal path, and the radio. The results of the system test, including a temperature measurement from the onboard TMP103 sensor, were reported on a wireless packet. During and after the tests, none of the boards reported a system failure. The temperature measurement data was plotted in Figure 38 and Figure 39 for visualization purposes.
4.2.4 Wireless RF Range

The wireless RF range was measured to be at least 54 meters in a typical office environment with a direct line of sight. A longer range could not be tested due to physical constraints imposed by the office building used for this test. Also, the transmit power on the CC2650 radio was set to 0 dBm.

This TI Design was able to successfully transmit data packets down the entire length of a 54-meter office building with minimal obstructions. However, radio performance will likely vary in the end-equipment environment because obstructions in the RF transmit path will reduce range. For full verification of the hardware transmitting characteristics of the TI Design, further testing with end-equipment context is required.
5 Design Files

5.1 Schematics

To download the schematics, see the design files at TIDA-00756.

Figure 40. CO Gas Sensor and Power Schematic
5.2 Bill of Materials

To download the bill of materials (BOM), see the design files at TIDA-00756.
5.3 PCB Layout Recommendations

To ensure high performance, the Low-Power Carbon Monoxide (CO) Detector With BLE and 10-Year Coin Cell Battery Life Reference Design was laid out using a four-layer PCB. The second layer is a solid GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The top and bottom layers are used for general signal routing and also have GND fills in unused areas. For all of the TI products used in this TI Design, adhere to the layout guidelines detailed in their respective datasheets.

If this design is to be used in an environment where dust or moisture accumulation is possible, be aware that it may be necessary to include a conformal coating to eliminate additional leakage paths due to the operating environment over time.

The antenna on this TI Design is the inverted F PCB antenna for 2.4-GHz transceivers and transmitters. See the application note DN0007 (SWRU120) for more details about layout and performance.

![Figure 42. Low-Power Carbon Monoxide Sensor Reference Design Layout Guidelines](image1)

![Figure 43. DC-DC Routing Guidelines](image2)

5.3.1 Layout Prints

To download the layer plots, see the design files at TIDA-00756.
5.4 **Altium Project**
To download the Altium project files, see the design files at TIDA-00756.

5.5 **Gerber Files**
To download the Gerber files, see the design files at TIDA-00756.

5.6 **Assembly Drawings**
To download the assembly drawings, see the design files at TIDA-00756.

6 **Software Files**
To download the software files, see the design files at TIDA-00756.

7 **References**
3. Texas Instruments, *2.4 GHz Inverted F Antenna*, DN007 Application Report (SWRU120)
4. Texas Instruments, WEBENCH® Design Center (http://www.ti.com/webench)

8 **About the Authors**
**CHRISTINA S. LAM** is a systems architect at Texas Instruments, where she is responsible for developing firmware for reference design solutions in the industrial segment. Christina has broad experience with applications processors, microcontrollers, and digital-signal processors with specialties in embedded firmware. Christina earned her bachelor of science (BS) in electrical and computer engineering from the University of Texas at Austin.

**GUSTAVO MARTINEZ** is a senior systems architect at Texas Instruments, where he is responsible for developing reference designs for industrial applications. Gustavo has ample experience developing system reference designs for the Smart Grid and home automation segments, which include high performance application processors, floating-point digital signal processors, and RF technology. Gustavo obtained his master of electrical engineering degree from the University of Houston and his bachelor of science in electrical engineering degree from the University of Texas at El Paso.
## Revision B History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

### Changes from A Revision (September 2016) to B Revision

<table>
<thead>
<tr>
<th>Changes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed all instances of LPV521 to LPV811</td>
<td>1</td>
</tr>
<tr>
<td>• Changed from LPV521 to LPV811 in front-page block diagram</td>
<td>1</td>
</tr>
<tr>
<td>• Changed from LPV521 to LPV811 in Figure 1</td>
<td>5</td>
</tr>
<tr>
<td>• Changed U1 from LPV521 to LPV811 in Figure 9</td>
<td>16</td>
</tr>
<tr>
<td>• Changed LPV521 to LPV811 in Figure 40</td>
<td>45</td>
</tr>
</tbody>
</table>

### Revision A History

### Changes from Original (July 2016) to A Revision

<table>
<thead>
<tr>
<th>Changes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed from preview page</td>
<td>1</td>
</tr>
<tr>
<td>• Changed Product Preview to Production Data.</td>
<td>6</td>
</tr>
</tbody>
</table>
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated ('TI') reference designs are solely intended to assist designers ('Designer(s)') who are developing systems that incorporate TI products. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.

TI's provision of reference designs and any other technical, applications or design advice, quality characterization, reliability data or other information or services does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such reference designs or other items.

TI reserves the right to make corrections, enhancements, improvements and other changes to its reference designs and other items. Designer understands and agrees that Designer remains responsible for using its independent analysis, evaluation and judgment in designing Designer's systems and products, and has full and exclusive responsibility to assure the safety of its products and compliance of its products (and of all TI products used in or for such Designer's products) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to its applications, it has all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems.

Designer may not use any TI products in life-critical medical equipment unless authorized officers of the parties have executed a special contract specifically governing such use. Life-critical medical equipment is medical equipment where failure of such equipment would cause serious bodily injury or death (e.g., life support, pacemakers, defibrillators, heart pumps, neurostimulators, and implantables). Such equipment includes, without limitation, all medical devices identified by the U.S. Food and Drug Administration as Class III devices and equivalent classifications outside the U.S.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a third party under the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED "AS IS" AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNERS AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS AS DESCRIBED IN A TI REFERENCE DESIGN OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TI's standard terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit products. Additional terms may apply to the use or sale of other types of TI products and services. Designer will fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer's non-compliance with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated